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Safety Information 
 

 

 

 

 

The CY4532 EZ-PD™ CCG3PA Evaluation Kit (EVK) is intended for use as an evaluation platform for hardware or software 
in a laboratory environment. The board is an open-system design, which does not include a shielded enclosure. Due to this 
reason, the board may cause interference to other electrical or electronic devices in close proximity. In such cases, take 
adequate preventive measures. Also, do not use this board near any medical equipment or RF devices.  

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its 
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable 
mitigating measures must be taken.  

 

 

The CY4532 EZ-PD CCG3PA EVK boards contain ESD-sensitive devices. Electrostatic charges 
readily accumulate on the human body and any equipment, which can cause a discharge without 
detection. Permanent damage may occur to devices subjected to high-energy discharges. Proper 
ESD precautions are recommended to avoid performance degradation or loss of functionality. Store 
unused CY4532 EZ-PD CCG3PA EVK boards in the protective shipping package. 

 

End-of-Life/Product Recycling 

The end-of-life cycle for this kit is five years from the date of manufacture mentioned on the back of 
the box. Contact the nearest recycler to discard the kit. 

 

General Safety Instructions 

ESD Protection  

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an 
ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap 
attached to the chassis ground (any unpainted metal surface) on the board when handling parts. 

Handling Boards 

The boards provided with CY4532 EZ-PD CCG3PA EVK are sensitive to ESD. This also applies to the boards that are 
provided with a plastic casing, when they are removed from the casing. Hold the boards only by the edges. After removing a 
board from the box/casing, place it on a grounded, static-free surface. Use a conductive foam pad, if available. Do not slide 
the board over any surface. 
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Do’s and Don’ts 

 

 

 

 

 Use only a compatible 2-Cell Li-Ion battery. Make sure that the battery is connected to the 
Battery Terminal (J1) of CY4532 Power Board as per the marked polarity (+/-) on the hardware. 
See Chapter 5. Kit Operation for more details. 

 Supply 12 V DC input only at the DC Jack (J3) of CY4532 Power Board. 

 Do not exceed 24 V DC input at the DC Terminal (J2) of CY4532 Power Board. 

 Do not connect any battery at the DC Terminal (J2) of CY4532 Power Board. 

 Do not supply DC input at Load Terminals (J4 and J5) of CY4532 Power Board. 

 Do not connect DC input at the DC Jack (J3) and battery at Battery Terminal (J1) 
simultaneously. 

 Do not apply more than 6.5 V on the test points. 

 Do not apply reverse voltage on the test points. 

 Do not connect USB Type-C Power Adapter to the USB Type-C port (J13) located on the 
CY4532 Power Board. 

 

Identifying Kit Revision and Serial Number 

The CY4532 kit revision and serial number are printed on a sticker and pasted at the bottom side of the CY4532 kit box. See 
the figure below for more details.  
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1.   Introduction 
 

 

The CY4532 EZ-PD™ CCG3PA Evaluation Kit (EVK) is based on the CCG3PA product family of Cypress’ USB Type-C 
microcontrollers. This EVK is intended to be an evaluation vehicle for USB Type-C Power Adapter (PA) and USB Type-C 
Power Bank (PB) applications. The kit can be configured for a PA or PB application using a combination of firmware, jumper 
settings on the kit hardware, and external accessories. The following paragraphs provide a brief description of both 
applications: 

 USB Type-C Power Adapter (PA): This application is used to charge a device such as a mobile phone or notebook, 
which supports their battery charging through the Type-C interface. The device can be connected to the Type-C port or 
Type-A port on the CY4532 EVK’s Main Board. This application requires a DC input to be supplied to the EVK.   

 USB Type-C Power Bank (PB): This application uses a 1-Cell or 2-Cell Lithium-ion battery connected to the CY4532 
EVK, which acts as the power source to support charging on USB Type-C and USB Type-A ports. In addition, the battery 
can be charged using a USB Type-C Power Adapter connected to the USB Type-C port of the EVK’s Main Board. 

In addition to the applications described above, the CY4532 Power Board can be used as a Programmer for Cypress 
EZ-PD CCGx Products supporting Configuration Channel (CC) boot-loading. See Chapter 5. Kit Operation for more 
details. 

1.1   Kit Contents 

The CY4532 EZ-PD CCG3PA EVK consists of the following: 

 CY4532 EZ-PD CCG3PA EVK Power Board 

 CY4532 EZ-PD CCG3PA EVK Main Board (pre-mounted on the CY4532 EVK Power Board) 

 12 V 50.4 W DC Power Adapter 

 Quick Start Guide 

Note: The Rev ** of the CY4532 EVK has a 12 V 24 W DC Power Adapter. 

1.1.1   Hardware Not Included with the Kit 
The CY4532 EZ-PD CCG3PA EVK does not come with all the hardware required to perform the demonstrations mentioned 
in Power Adapter (PA) Demo and Power Bank (PB) Demo sections of Chapter 5. Kit Operation. The following items are not 
included: 

 A USB Type-C device that can consume power over the Type-C port (example: laptop or mobile phone with USB Type-
C port) 

 A device that can be charged over the USB Type-A interface (example: mobile phone which can be charged through the 
USB port) 

 1-cell (2.7 V–4.2 V) or 2-cell (5.4 V–8.4 V) Li-ion battery 

 USB Type-C Power Adapter. This is required to charge the battery attached to the CY4532 EVK in PB use-case. 

 USB cables required for connecting the devices to the USB Type-C and Type-A ports 
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1.2   Getting Started 

For instructions on how to run a quick demonstration and observe the kit functionality, see the Power Adapter (PA) Demo 
section. 

1.3   Acronyms 

Table 1-1. Acronyms Used in this Document 

Acronym Definition 

AFC Adaptive Fast Charging 

BC Battery Charging  

CC Configuration Channel 

CCG Cable Controller Generation 

DFP Downstream Facing Port 

DRP Dual Role Port 

EC Embedded Controller 

EMCA Electronically Marked Cable Assembly 

EMI Electromagnetic Interference 

ESD Electrostatic Discharge 

EVK Evaluation Kit 

FET Field-Effect Transistor 

GPIO General-Purpose Input/ Output 

IC Integrated Circuit 

I2C Inter-Integrated Circuit 

LED Light-Emitting Diode 

NA Not Applicable 

OCP Over Current Protection 

PA Power Adapter 

PB Power Bank 

PD  Power Delivery 

PDO Power Data Object 

PPS  Programmable Power Supply  

PMIC Power Management Integrated Circuit 

PS Power Supply 

PSoC® Programmable System-on-Chip 
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Acronym Definition 

QC Qualcomm Quick Charge 

SWD Serial Wire Debug 

UART Universal Asynchronous Receiver Transmitter 

UFP Upstream Facing Port 

USB Universal Serial Bus 

USB-PD Universal Serial Bus Power Delivery 
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2.   Kit Installation 
 

 

 

This chapter describes the procedure to install the CY4532 EZ-PD CCG3PA EVK software.  

2.1   CY4532 EZ-PD™ CCG3PA EVK Kit Software Installation 

To install the kit software, follow these steps: 

1. Download the latest kit software setup file CY4532Setup.exe from the kit’s webpage www.cypress.com/CY4532. This 
package contains the kit hardware files, firmware binaries, and the kit documentation (Kit Guide, Quick Start Guide, and 
Release Notes). Double-click the executable to start the installation. Click Next when the screen shown in Figure 2-1 
appears. 

Figure 2-1. CY4532 EZ-PD CCG3PA EVK Installer Screen 

 

 

2. Select the required Installation Type and click Next to start the install (Figure 2-2). For first-time installation, it is 
recommended that you select Typical as the Installation Type. 

 

 

 

 

http://www.cypress.com/CY4532
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Figure 2-2. Installation Wizard 

 

 

3. Accept the license agreement for the software components and click Next (Figure 2-3). 

Figure 2-3. License Agreement 
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Figure 2-4 shows the installation progress. 

Figure 2-4. Installation Progress 

 

 

4. Enter the Contact Information or select Continue Without Contact Information and click Finish. (Figure 2-5). 

Figure 2-5. Software Installation Complete 
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5. When installation is complete, you have the option to launch the Cypress Update Manager (Figure 2-6) to make sure 
you have the latest software package. Click Check for updates at the bottom of the window. If No Updates appears 
adjacent to the CY4532 EZ-PD CCG3PA EVK, click Exit. If there are updates, click Update to download and install the 
latest kit package. 

Figure 2-6. Cypress Update Manager 

 

 

Note: You can launch the Cypress Update Manager at any time from Start > All Programs > Cypress > Cypress Update 
Manager. 

After the installation is complete, the contents are available at this location: <Install Directory>\CY4532 EZ-PD CCG3PA 
EVK\1.0\. 

Note: On the Windows 32-bit platform, the default <Install Directory> is C:\Program Files\Cypress; on the Windows 64-bit 
platform, it is C:\Program Files(x86)\Cypress. 
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3.   CY4532 System Design Details 
 

 

 

3.1   CY4532 EVK System Overview 

This section provides details on the system capabilities of the CY4532 EVK. The kit supports USB Type-A and USB Type-C 
ports for charging. 

3.1.1   Power Adapter Application 
For a Power Adapter (PA) application, the input power source is the DC adapter provided with the EVK. It is rated for 50.4 W 
(12 V/4.2 A) of power, so the total output power including both charging ports is limited to 50.4 W. Applications may charge 
two devices simultaneously, one on the USB Type-A port and other on the USB Type-C port, if these adhere to the 50.4 W 
limit, failing which the charging may intermittently or completely stop. 

Table 3-1 lists the specifications for the DC adapter to be used with the CY4532 EVK.  

Table 3-1. Specifications of the DC Adapter to Use with CY4532 EVK 

Parameter Min Max 

DC Voltage 6 V 12 V 

DC Current - 5 A 

 

Table 3-2 lists the charging protocols supported on the USB Type-A port. 

Table 3-2. Charging Protocols Supported on USB Type-A Port 

Protocol CY4532 Operating Specification 

QC 3.0 (Qualcomm Quick Charge) 3.6 V – 20 V 

Apple Charging 5 V, 2.4 A 

Samsung AFC (Adaptive Fast Charging) 5 V, 3 A 

9 V, 2.1 A 

12 V, 1.05 A 

BC 1.2 (Battery Charging) 5 V 
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Table 3-3 lists the charging protocols supported on the USB Type-C port. 

Table 3-3. Charging Protocols Supported on USB Type-C Port 

Protocol CY4532 Operating Specification 

USB Type-C and PD  5 V, 3 A 

9 V, 3 A1 

QC 4.0 / PPS 2 3 V - 11 V, 3 A 

QC3.0 3.6 V- 20 V   

QC 2.0  5 V, 9 V, 12 V, 20 V 

Apple Charging 5 V, 2.4 A 

Samsung AFC (Adaptive Fast Charging) 5 V, 3 A 

9 V, 2.1 A 

12 V, 1.05 A 

BC 1.2 (Battery Charging) 5 V 

Note: 
1. Default Power Bank Application supports 9 V, 2 A  
2. Supported only for Power Adapter application  

 
If an application uses a USB Type-C-to-Type-A converter on the USB Type-C port, all charging protocols supported on the 
USB Type-A port of the EVK are applicable. 

The USB Type-C port has the over-current protection (OCP) feature implemented in the system. If the charging current 
exceeds the negotiated contract current by more than 30%, CCG3PA will treat this as a fault and stop charging on the USB 
Type-C port. 

The CY4532 Kit has an additional feature to support VCONN supply for cable discovery in the Power Adapter application. 
The CY4532 Kit hardware and firmware require changes to exercise the VCONN operation. Please contact Cypress Technical 
Support through www.cypress.com/support to enable the VCONN operation on the CY4532 Kit. 

Applications that exceed the CY4532 operating specifications need a DC adapter with a higher power rating; however, it 
should not exceed the specifications mentioned in Table 3-1. Changes in the PA firmware are also required for exceeding the 
CY4532 operating specifications to avoid OCP fault on the USB Type-C port. 

3.1.2    Power Bank Application 
For Power Bank (PB) applications, use standard-quality Li-Ion batteries. Table 3-4 lists the specifications of the battery to 
be used with the CY4532 Kit for 2-Cell and 1-Cell operations. 

Table 3-4. Specifications of 2-Cell and 1-Cell Batteries 

Parameter 
2-Cell Specification 1-Cell Specification 

Min Max Min Max 

DC Voltage 5.5 V 8.4 V 3.7 V 4.2 V 

Charging Current 200 mA 3 A 200 mA 3 A 

Discharging Current 3 A 5 A 3 A 5 A 

 

Charging protocols listed in Table 3-2 and Table 3-3 are applicable for the Power Bank application as well. 

For applications that exceed the CY4532 operating specifications, a higher current rated battery is desired; however, the 
battery should not exceed specifications listed in Table 3-4. For exceeding the CY4532 operating specifications, applicable 
changes in PB firmware are also required to avoid OCP fault on the USB Type-C port. 

Important Note: It is recommended to use 2-Cell battery as the maximum charging current supported by the EVK with 1-Cell 
battery operation is limited to 1.5 A. The charging may stop when the charging current exceeds 1.5 A. 

http://www.cypress.com/support
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3.2   CY4532 EVK Hardware Overview 

The CY4532 EZ-PD CCG3PA EVK consists of a Power Board and a Main Board. The Main Board is pre-mounted on the 
Power Board during manufacturing. The CCG3PA device is located on the Main Board. The CY4532 hardware architecture 
is captured in Figure 3-1. 

Figure 3-1. CY4532 EZ-PD CCG3PA EVK Architecture 

 

 

The CY4532 Power Board consists of the following key components: 

 A DC Input Jack 

 A Battery Input Terminal 

 A Micro-USB connector to download firmware to CCG3PA 

 A Type-C receptacle to enable programming of an external CCG3PA based hardware 

 Regulators to support battery charging and to provide power for the USB Type-C and USB Type-A charging  

The CY4532 Main Board consists of following the key components: 

 CCG3PA silicon (CYPD3171-24LQXQ) 

 A Type-C receptacle  

 A USB Type-A connector 

 MiniProg3 SWD header to program CCG3PA 

The Main Board is mounted on the Power Board using two 26-pin connectors.  
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3.3   CY4532 Power Board 

The CY4532 Power Board implements all the interfaces and logic to provide the required power supplies to the CY4532 Main 
Board. This board provides interfaces to connect a DC power input (for PA application) or a battery input terminal (for PB 
application).  

3.3.1   Block Diagram 
The block diagram of the CY4532 Power Board is shown in Figure 3-2. It provides two interfaces (DC Barrel Jack and DC 
Screw Terminals) to provide DC input power using an AC-DC power adapter or using a bench power supply respectively. It 
also includes a Battery Terminal to connect a 1-cell or 2-cell Li-ion battery. The input power mechanism (DC supply or battery) 
is selected using a switch (SW1).  

Figure 3-2. CY4532 Power Board Block Diagram 

 

 

The Power Board contains the following key parts: 

 SC8802 (U1): This is a bidirectional buck boost regulator connected to the USB Type-C port on the main board. In the 
PA application, this part regulates the VBUS (VBUS_P) voltage from 3 V to 20 V on the USB Type-C port as per the PD 
contract negotiated with the device being charged. The input voltage range for this part is 2.7 V to 24 V.  

In the PB application, when the battery is being charged, this part provides power from the VBUS input (VBUS_P) to the 
battery. The VBUS voltage of 3 V to 20 V supplied from a USB Type-C charger is fed to this part and it controls the power 
supplied to the battery as per the battery type (1-cell or 2-cell). 

 SC8701 (U2): This is a buck boost regulator connected to the USB Type-A port located on the CY4532 EVK Main Board. 
In both the PA and PB applications, it supplies power from the DC input/battery to provide the VBUS output 
(VBUS_TYPE_A) on the Type-A port. The input voltage range for this part is 2.7 V to 24 V. 

 TPS63060DSCR (U4): This is a buck boost regulator that provides a constant 5 V output. The input supply to this part is 
provided through the DC jack (J3) or the Battery input (J1), based on the SW1 switch setting. The recommended input 
voltage range for this part is up to 12 V only. The output from this part is used to provide: 

 VDDD supply to the CCG3PA device located on the CY4532 EVK Main Board 

 5 V on the USB Type-A port of the CY4532 EVK Main Board to detect a device plug-in 

 VBUS on the USB Type-C port of the CY4532 EVK Power Board to enable flashing of an external CCG3PA based 
hardware 

 CYPD4126-40LQXI (U3): This is a Cypress CCG4 controller part. It enables downloading firmware on to the CCG3PA 
part (which is located on the CY4532 EVK Main Board) using the EZ-PD configuration utility. It is connected to the 
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CCG3PA device using the CC lines. The CCG4 controller is connected to a Cypress USB-Serial part (U7) over I2C to 
receive the CCG3PA firmware. 

Note: The CY4532 EVK Power Board can be used as an external CCG3PA programming accessory. The CY4532 EVK 
Main Board should not be connected to the Power Board for this use case. The CC lines of the CCG4 part are terminated 
at a USB Type-C receptacle on the Power Board. External CCG3PA based hardware can be connected to this USB 
Type-C receptacle to download firmware using the EZ-PD configuration utility running on a PC.  

 CY7C65211 (U7): This is Cypress’ USB-Serial part that is connected to the USB Micro-B connector (J12) of the CY4532 
EVK Power Board. It is also connected to the CCG4 part over I2C. This part enables downloading the firmware on to the 
CG3PA device (which is located on the CY4532 EVK Main Board) through the USB Micro-B port of the CY4532 Power 
Board. 

3.3.2   Features 
Table 3-5 lists the features of the CY4532 EVK Power Board. 

Table 3-5. CY4532 EVK Power Board Features 

Feature Description 

Power Supplies 

The input power can be provided through the DC input interface or the battery. The input supply is 
fed to SC8802 and SC8701 to enable charging through USB Type-C and USB Type-A ports. In 
addition, SC8802 supports charging of a battery connected to the Power Board. 

Note: The DC power adapter provided with the kit can support only up to 4.2 A (at 12 V). The 
CY4532 EVK will not work with 5 V DC power adapters. 

CY4532 Main Board 
Connectors 

Two 26-pin connectors (Interface Connector and Support Connector) are available on the Power 
Board to connect it to the Main Board. 

Firmware Download Interface 
The CCG3PA firmware can be downloaded to the CCG3PA device located on the Main Board 
through the USB Micro-B interface available on the Power Board. 

3.3.3   Connectors and Jumper Settings 
Figure 3-3 shows the CY4532 Power Board connectors and the default jumper settings.  

Table 3-6 lists the detailed description of the connectors and jumper settings. 

Figure 3-3. CY4532 Power Board Connectors 
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Table 3-6. CY4532 Power Board Connector/Jumper/LED Description 

Connector/ 
Jumper 

Description Type Purpose Default State 

J1 Battery Terminal Input To connect a 1-cell or 2-cell Li-ion battery 

Battery voltage range: 2.7 V (Min) to 8.4 V (Max) 

NA 

J2 DC Terminal Input To connect any external power supply with the board 

Supply voltage range: 6 V (Min) to 24 V (Max) 

The board's default configuration does not support the usage of 
this terminal. See the CY4532 EVK’s Power Board schematics to 
understand the usage of this terminal. 

NA 

J3 DC Jack Input 12 V DC power adapter provided with the kit can plugged into 
this jack. 

The AC/DC adapter shipping with the kit will provide 12 V with a 
current up to 4.2 A. If you need additional power sourcing, you 
can use your choice of power adapter that can source more 
current at 12 V. 

NA 

J4 Load Terminal 2 
(Type-C Sink) 

Output For future use NA 

J5 Load Terminal 1 
(PB) 

Output To connect an external electronic load for the PB application to 
emulate the battery charging current 

Load range: 0 A (Min) to 5 A (Max) 

Note: Make sure to connect the load on J5 and not on J4. 

NA 

J6 VCONN Selection 
Jumper 

Input To enable the VCONN operation on the Power Board for PA 
application 

Short pins 1 and 2 

J7 VCONN Selection 

Jumper 

Input To enable the VCONN operation on the Power Board for PA 
application 

Short pins 1 and 2 

J9 AXRES Isolation 

Jumper 

Input To isolate the AXRES pin of CCG3PA device on the Main Board 
from the Power Board. 

Short pins 1 and 2 

J10 Interface 
Connector 

Input/ 
Output 

To connect various control signals from the CCG3PA to the 
regulators. 

NA 

J11 Support Connector  Input/ 
Output 

To connect CCG4’s CC signals and other signals between the 
Power board and the Main board 

NA 

J12 USB Micro-B 
receptacle 

Input/ 
Output 

Interface to download firmware on to the CCG3PA part NA 

J13 USB Type-C 
receptacle 

Input/ 
Output 

External CCG3PA programming interface NA 

J14 LED Jumper  NA This jumper connects power to anode of LED1.  If the jumper is 
not installed LED indication will stop as there is no power 
supplied to LED. 

Short pins1 and 2 

LED1 Power LED Output LED to indicate that the board is powered either from a DC 
adapter, a battery, or an external Type-C charger. 

 OFF 

 

Note: In Rev ** of the CY4532 EVK, the features listed in Table 3-7 are different from those listed in Table 3-6.  

Table 3-7. Connector/Jumper/LED Differences 

Connector/Jumper Remark/Difference Default state 

J12 USB Mini-B receptacle instead of USB Micro-B receptacle NA 

J14  Not Present NA 

LED1 
LED will blink for a second when the board is powered either from a 
DC adapter, a battery, or an external Type-C charger. 

OFF 
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The Rev ** of the CY4532 EVK also can be identified using the board revision numbers listed in Table 3-8. These revision 
numbers are printed on the silk screen of the boards: 

Table 3-8. Board Revision Numbers 

# Board Revision Number Printed on the Silk Screen 

1 CY4532 EZ-PD CCG3PA EVK MAIN BOARD 600-60412-01 REV04 

2 CY4532 EZ-PD CCG3PA EVK POWER BOARD 600-60414-01 REV04 

 

3.4   CY4532 Main Board 

The CY4532 Main Board consists of the CCG3PA silicon (CYPD3171-24LQXQ), USB Type-C and USB Type-A ports and a 
MiniProg3 SWD header. The Main Board is mounted on the Power Board using two sets of connectors. 

3.4.1   Block Diagram 
Figure 3-4 shows the block diagram of the CY4532 EVK Main Board. 

Figure 3-4. CY4532 EVK Main Board Block Diagram 

 

The Main Board contains the following key parts: 

 CYPD3171-24LQXQ (U1): This is the CCG3PA controller with the required control logic to implement PA and PB 
applications. 

 Power MOSFETs (Q1 and Q2): These MOSFETs are P-Channel devices which control the Provider and the Consumer 
paths for VBUS at the Type-C connector. 
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3.4.2   Features 
Table 3-9 lists the features of the CY4532 EVK Main Board. 

Table 3-9. CY4532 EVK Main Board Features 

Feature Description 

CCG3PA controller The CYPD3171-24LQXQ part is located on the Main Board. This part implements the PA and PB control 
functionality 

USB Type-C 
Source/Sink Port 

A USB Type-C receptacle to attach devices that can consume power over a USB Type-C port (PA and PB 
applications) and to charge the battery connected to the power board (PB application) 

USB Type-A Source 
Port 

A USB Type-A receptacle to attach devices that can consume power over USB Type-A 

Programming SWD pins to debug/program CCG3PA using MiniProg3 (not required if the EZ-PD configuration utility is used) 

 

3.4.3   Connectors and Jumper Settings 
Figure 3-5 shows the CY4532 Main Board connectors and default settings of the jumpers. 

Table 3-10 lists the detailed description of the connectors/jumper settings 

Figure 3-5. CY4532 EVK Main Board Connector/Jumper Settings 

  

  

http://www.cypress.com/?rID=38154
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Table 3-10. CY4532 EVK Main Board Connector/Jumper Description 

Connector/ 
Jumper 

Description Type Purpose Default State 

J2, J3, J4, 
and J6 

Mode Selection Jumpers Input To configure the Main Board for PA/ PB/ FW 
download/ MiniProg3 mode 

Note: Current consumed by the CCG3PA 
controller can be measured at J6 at any point 
of time. 

Short pins 1 and 2  

J5 and J7 FW Download Mode Jumpers Input To enable firmware download through the 
USB Mini-B connector located on the Power 
Board 

Open 

J9 USB Type-A Source Port (Type-A 
receptacle) 

Input/Output USB Type-A receptacle to attach devices that 
can consume power over a USB Type-A port 

NA 

J10 USB Type-C Source/Sink Port (Type-
C receptacle) 

Input/Output USB Type-C receptacle to attach devices 
which can consume power over a Type-C port 
(PA and PB applications) and to charge the 
battery connected to the EVK (PB application) 

NA 

J11 Interface Connector Input/Output To connect the control signals from CCG3PA 
to the power regulators. 

NA 

J12 Support Connector  Input/Output To connect CCG4’s CC signals and other 
signals between the Power board and Main 
board 

NA 
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4.   Programming the EZ-PD CCG3PA 
Controller 

 

 

 

The CCG3PA controller on the CY4532 EZ-PD CCG3PA EVK is pre-programmed with the latest PA firmware binary image 
at the time of manufacturing. However, a newer firmware image may be available on the CY4532 EZ-PD CCG3PA EVK 
webpage and with the CY4532 EZ-PD CCG3PA EVK installer. The firmware version of the onboard CCG3PA controller can 
be verified by using the EZ-PD Configuration Utility as shown in Figure 4-4. 

If the onboard CCG3PA controller’s firmware version does not match the latest version on the CY4532 EZ-PD CCG3PA EVK 
webpage, follow the steps in this chapter to reprogram the CCG3PA device with the latest firmware. Device configuration 
parameters (such as vendor ID, Power Data Objects (PDOs), and so on) can be updated using the EZ-PD Configuration 
Utility. See the EZ-PD Configuration Utility User Manual available in the EZ-PD Configuration Utility webpage. 

4.1   Programming the CCG3PA Controller on the CY4532 EVK 

4.1.1   Procedure to Program the CCG3PA Controller 
The EZ-PD Configuration Utility is a Windows Application, which can be used to configure and program the CCG3PA controller 
on the CY4532 Main Board. Steps to update the firmware running on the CCG3PA controller are as follows: 

1. Download and install the latest kit software setup file “CY4532Setup.exe” from the kit’s webpage: 
www.cypress.com/CY4532. This installs the EZ-PD Configuration Utility as well. 
Note: Make sure that no devices are connected on the Type-C or Type-A ports of the CY4532 EVK before proceeding 
with the next step. 

2. Set the jumpers on the CY4532 Main Board and Power Board as list in Table 4-1. 

Table 4-1. CY4532 EVK Jumper Settings for programming the CCG3PA Controller 

Board Type Jumper Header Status 

Main Board J2 Short 1 and 2 if the existing FW 
loaded on the EVK is PA firmware. 
Short 2 and 3 if PB firmware is 
loaded 

J3 

J4 

J6 Short 1 and 2 

 J5 

J7 

Power Board J6 Open 

J7 Open 

J9 Open 

 

Note: See Appendix C - Identifying the Application Firmware Type for instructions to identify the application firmware 
already loaded on the EVK. 

3. Apply power to the EVK as per the existing firmware loaded on the EVK. If PA firmware is loaded, power the EVK using 
the DC Input. If PB firmware is loaded, power the EVK using the Battery Input. Make sure that the Input Power 
Selection Switch (SW1) is set as per the type of power input used. 

4. Connect a USB Type-A to Micro-B cable from a host PC to connector J12 on the Power Board as shown in  
Figure 4-1.  

Note: For the Rev ** of the CY4532 EVK, use USB Type-A to Mini-B cable. 

http://www.cypress.com/CY4532
http://www.cypress.com/CY4532
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
http://www.cypress.com/CY4532
http://www.cypress.com/CY4532
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility
http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility?source=search&cat=software_tools
http://www.cypress.com/CY4532
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Figure 4-1. Programming the CCG3PA Controller on the CY4532 EZ-PD CCG3PA EVK 

 

5. Launch the EZ-PD Configuration Utility as shown in Figure 4-2. After installation, the EZ-PD Configuration Utility is 
available on the start menu at: 

Windows > Start > All Programs > Cypress > EZ-PD Configuration Utility > EZ-PD Configuration Utility 

Figure 4-2. EZ-PD Configuration Utility 

 

Confirm that the Utility’s status bar displays the connection with two devices as shown in Figure 4-2. 
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6. Select Tools > Firmware Update to update the firmware of the CCG3PA controller as shown in Figure 4-3. See the 

Utility’s User Manual available on the EZ-PD Configuration Utility webpage for more details. You can also click Help > 

User Manual in the EZ-PD Configuration Utility to access this user manual. 

Figure 4-3. Upgrading the CCG3PA Firmware 

 

  

7. Download the latest firmware images from the CY4532 EZ-PD CCG3PA EVK webpage. Select the type of firmware 

(PA/PB application). The firmware filenames are: 

 PA: CYPD3171-24LQXQ_cla_<version>_pa.cyacd 

 PB: CYPD3171-24LQXQ_pb_<version>_pb.cyacd 

The CCG3PA controller firmware is provided in the.cyacd format. The latest firmware binary for each application and the 
standard part numbers are provided on the CY4532 EZ-PD CCG3PA EVK webpage. The firmware images are also 
available at the following location after the CY4532 EZ-PD CCG3PA EVK installation: <Install_Directory>\CY4532 EZ-
PD CCG3PA EVK\1.0\Firmware 

8. Select UFP-AMA from the Select target list shown in Figure 4-4. Click the button located next to   

Firmware path 1 at the top of the window and navigate to the location of the firmware image. 

  

http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility?source=search&cat=software_tools
http://www.cypress.com/CY4532
http://www.cypress.com/CY4532
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Figure 4-4. Updating Firmware Using EZ-PD Configuration Utility 

 

Note: The current firmware version is displayed as Base version under Firmware as shown in Figure 4-4. 

9. Click Program to initiate the firmware update process. The status bar at the bottom of the utility will show the progress. 

The firmware update process can take around six minutes to complete. 

Figure 4-5. Firmware Update Process 

 

Warning: Do not disconnect the EVK from the PC/laptop while the firmware update is in progress.  

10. Upon successful completion of the firmware update process, a window  with the message “Flash updated successfully” 

is displayed as shown in Figure 4-6. Click OK. 



   Programming the EZ-PD CCG3PA Controller 

CY4532 EZ-PD™ CCG3PA Evaluation Kit Guide, Doc. No. 002-18680 Rev. *B 27 

Figure 4-6. Completion of Firmware Update Process 

 

 

Note: If the firmware type being downloaded is different from the earlier firmware (for example, downloading a PB 
firmware on an EVK with PA firmware), the dialog box will display “Firmware/Configuration upgrade not completed. 
Refer Message window for details” as shown in Figure 4-7 instead of “Flash updated successfully”. This error message 
comes up because the new firmware which was written to flash is unable to start since the jumper settings have not yet 
been changed to support the new firmware. This error message displayed on the dialog box can be ignored if 
“Firmware/Configuration write to flash completed” message is seen in the message window of the EZ-PD Configuration 
Utility GUI as shown in Figure 4-8.  

Figure 4-7. Downloading a Different Application Firmware Type: Pop-up Message 

 

Note: This pop-up message may not appear if successful contract is made after switching the firmware. 
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Figure 4-8. Downloading a Different Application Firmware Type: Log Window  

 

 

11. Configure the jumper settings as per the downloaded firmware requirements (PA/PB) and power cycle the CY4532 

EVK to use the new firmware. 
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4.1.2   Common Problems and Troubleshooting 

Table 4-2. Common Problems and Troubleshooting for Programming 

# Issue Possible Cause Possible Solution(s) 

1 Unable to download 
firmware. UFP-AMA entry 
is not seen in the Select 
target window of the EZ-
PD Configuration Utility 

Jumpers J2, J3, and J4 on the CY4532 
EVK Main Board may not have been set 
correctly as per the existing firmware 
loaded on the EVK. 

 

 

 

Identify the existing application firmware  
(PA/PB) loaded on the CY4532 EVK using 
the procedure described in  
Appendix C - Identifying the Application 
Firmware Type, set the jumpers J2, J3, and 
J4 as per the application firmware and 
download the firmware again. 

 

Power may not have been supplied as 
per the existing firmware loaded on the 
EVK. 

Provide power using the correct supply (DC 
Power Adapter/Battery) and position the 
Power Selection Switch (SW1) as per the 
power supply used. 

2 A pop-up message 

“Firmware/configuration 
upgrade not completed. 
Refer message window for 
details” is displayed. 

This is expected if the new firmware is of 
different application than the previous 
one, as the jumpers J2, J3, and J4 on the 
main board are set for previous 
application. 

See Figure 4-7 and the explanation 
associated with it. 

None 
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5.   Kit Operation 
 

 

 

This chapter describes how to configure the CY4532 EZ-PD CCG3PA EVK to demonstrate the functionality as a  
USB Type-C Power Adapter (PA) and a USB Type-C Power Bank (PB). Two separate demonstrations are covered: 

 Power Adapter (PA) Demo 

 Power Bank (PB) Demo 

Important Note: Before starting the demo make sure that the EVK is loaded with the intended firmware. Running a PA demo 
on an EVK loaded with PB firmware and vice versa can damage the EVK hardware including the CCG3PA silicon.  
Appendix C - Identifying the Application Firmware Type explains the procedure to identify the firmware type loaded on the kit. 

Following is the list of USB Type-C and USB Type-A devices and power adapters which have been tested with the CY4532 
EVK: 

 USB Type-C devices 

 Apple MacBook Pro 

 LeEco Le Max 2 Phone 

 USB Type-A devices 

 iPhone 6 

 iPad Air 

 Samsung Note 3 

 USB Type-C Power Adapter 

 Apple 29W USB-C Power Adapter 

It is recommended to use USB Type-A devices which are compliant with QC 3.0, Apple Charging 2.4A, Samsung AFC, and 
BC 1.2 charging protocols with the CY4532 EVK. Contact Cypress Technical Support through www.cypress.com/support for 
additional support. 

In addition, this chapter explains the procedure to use the CY4532 Power Board as a Programmer for an external hardware 
with a Cypress EZ-PD CCGx Product supporting the CC bootloading feature. 

5.1   Power Adapter (PA) Demo 

The Power Adapter demo is a full end-to-end demo that demonstrates how to provide power through the USB Type-C and 
USB Type-A interfaces using an external supply.  

The following items are needed to perform this demo: 

 Items provided with the kit: 

 12 V 50.4 W DC power adapter 

 CY4532 EZ-PD CCG3PA EVK boards (Power Board and Main Board) 

 
  

http://www.cypress.com/support
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 Items not provided with the kit: 

 Type-C device which can consume power over the USB Type-C (Example: A Laptop or Mobile Phone with USB 
Type-C port) 

 A device which can be charged by connecting to the USB Type-A interface (Example: A Mobile Phone which can be 
charged through the USB port) 

 USB cables to connect the devices to the Type-C and Type-A interfaces  

5.1.1   Running the Power Adapter Demo 
1. If the firmware has been changed from the default Power Adapter (PA) firmware, load the power adapter firmware first. 

See the Programming the CCG3PA Controller on the CY4532 EVK section for more details. 

2. Set the jumpers on the CY4532 Main Board and Power Board as specified in Table 5-1. 

Table 5-1. CY4532 EVK Jumper Settings for the Power Adapter Demo 

Board Type Jumper Header Status 

Main Board J2 Short pins 1 and 2 

J3 

J4 

J6 

J5 Open 

J7 

Power Board J6 Short pins 1 and 2 

J7 

J9 

J14 

 

3. Set the Input Power Selection Switch (SW1) on the Power Board to the ‘DC INPUT’ position.  

4. Connect the 12 V DC power adapter provided with the kit to the CY4532 Power Board’s power jack J3. The Green LED 
(LED1) on the CY4532 EVK Power Board turns ON to indicate that the kit is powered. 

Note: In Rev ** of the CY4532 EVK, the LED1 will blink for a second to indicate that the kit is powered. 
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Figure 5-1. Setup for Power Adapter Demo 

 

 

5. Connect a USB Type-C device to the Type-C port (J10) located on the Main Board.  

Note: The voltage provided by the CY4532 EVK to the device is determined based on the USB PD contract negotiated 
between the CY4532 EVK and the device. The PA firmware supports 5V, 9V and 12V output. This voltage can be 
monitored at the VBUS_P test point (TP14) located on the Power Board. 

6. Connect a USB Type-A device such as mobile phone on the Type-A receptacle (J9) to charge it. 

Note: CY4532 supports simultaneous charging through the Type-C and Type-A ports. The voltage provided by the 
CY4532 kit to the device connected on the Type-A interface can be monitored at the SUPPLY_TYPE_A test point (TP12) 
on the Power Board. 

7. Check the user feedback provided by the device (for example, battery charging status on the display of a mobile phone) 
connected to the USB Type-C and/or Type-A interfaces to determine the charging status. Disconnect the device from 
CY4532 once charging is completed to the desired level. 
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5.1.2   Common Problems and Troubleshooting 

Table 5-2. Common Problems and Troubleshooting for PA Application 

# Issue Possible Cause Possible Solution(s) 

1 The Type-C or Type-A device 
connected to the CY4532 is not 
getting charged. 

Switch SW1 may not be at ‘DC INPUT’ 
position. 

Set the Switch SW1 to ‘DC INPUT’ 
position. 

CY4532 may not have been loaded with 
‘Power Adapter’ firmware. 

Download ‘Power Adapter’ firmware 
using the details provided in  
Chapter 4. Programming the EZ-PD 
CCG3PA Controller. 

2 The device that is connected to the 
USB Type-A port gets charged 
intermittently. 

The device may implement a proprietary 
charging protocol instead of BC 1.2, QC, 
Apple Charging 2.4A, or Samsung AFC 
protocols. 

CY4532 EVK supports charging using 
BC 1.2, QC, Apple Charging 2.4A, and 
Samsung AFC protocols. Make sure that 
the device connected to CY4532 EVK is 
compliant with one of these protocols. 

3 Unable to charge through the USB 
Type-C and USB Type-A ports 
simultaneously. 

Note that the total power which can be 
provided to the devices is limited to 50.4 W 
with the DC adapter provided with the EVK. 

Use another DC adapter with higher 
power output. CY4532 EVK can support 
up to 12 V, 5 A DC input at J3. 

4 Device connected to the USB Type-C 
port does not get charged or stops 
charging. 

CY4532 EVK implements OCP for safety. 
This shuts down charging on the Type-C 
port if the current exceeds a certain limit. 
By default, this limit is set to 2 A. 

Check if the device connected to the 
USB Type-C port can be configured to 
set the current consumption limit to 2 A. 

5 Charging of the devices connected on 
the Type-C and Type-A ports goes 
through intermittent charging cycles 
before it stabilizes 

CY4532 EVK supports multiple charging 
protocols (QC, Samsung AFC, BC 1.2, 
Apple Charging 2.4A). The communication 
between the EVK and the device being 
charged to align on the optimal voltage and 
current settings can happen in steps. 

None 

 

5.2   Power Bank (PB) Demo 

The Power Bank demo is a full end-to-end demo that demonstrates how to: 

 Charge a 1-cell or 2-cell Lithium-ion battery connected to the CY4532 EVK 

 Provide power through the USB Type-C and USB Type-A ports of the CY4532 from a 1-cell or 2-cell Lithium-ion battery 

Note: Only use a Li-Ion battery with an appropriate protection circuit, and proper insulation between its terminals. 

This is the recommended 2-cell battery: http://www.batteryspace.com/custom-li-ion-18650-battery-7-2v-17-5ah-126wh-
4a-rate-2x5s-s-inr18650-mj1.aspx. 

5.2.1   Required Boards, Cables, and Accessories  
The following items are needed to perform this demo: 

 Items provided with the kit: 

 CY4532 EZ-PD CCG3PA EVK boards (Power Board and Main Board) 

 Items not provided with the kit: 

 A USB Type-C device that can consume power over Type-C (for example, a laptop or mobile phone with Type-C 
port) 

 A USB Type-C Power Adapter to charge the battery 

 A device which can be charged by connecting to USB Type-A interface (for example, a mobile phone which can be 
charged through the USB Type-A port) 

 1-cell or 2-cell Lithium-ion battery 

 USB cables to connect the devices to the Type-C and Type-A interfaces 

http://www.batteryspace.com/custom-li-ion-18650-battery-7-2v-17-5ah-126wh-4a-rate-2x5s-s-inr18650-mj1.aspx
http://www.batteryspace.com/custom-li-ion-18650-battery-7-2v-17-5ah-126wh-4a-rate-2x5s-s-inr18650-mj1.aspx
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5.2.2   Running the Power Bank Demo 

5.2.2.1 Charging the Battery Attached to CY4532 EVK 

1. Program the latest Power Bank (PB) firmware into the kit. See the Programming the CCG3PA Controller on the CY4532 
EVK section 4.1  for details. 

Note: By default, the CY4532 EVK is configured to support a 2-cell battery. See Appendix B - Configuring CY4532 EVK 
for 1-Cell or 2-Cell Li-Ion Battery Operation to configure the EVK for 1-cell battery operation. 

2. Remove the power supply connected on the DC Jack (J3). 

3. Set the jumpers on the CY4532 Main Board and Power Board as specified Table 5-3. 

Table 5-3. CY4532 EVK Jumper Settings for the Power Bank Demo 

Board Type Jumper Header Status 

Main Board J2 Short pins 2 and 3 

J3 

J4 

J6 Short pins 1 and 2 

J5 Open 

J7 

Power Board J6 Short pins 1 and 2 

J7 

J9 

J14 

 

4. Connect a 2-cell Lithium-ion battery to the battery terminal (J1). 

Important Note: Make sure that the battery terminals are connected to the CY4532 Power Board as per the positive (+) 
and negative (-) terminals marked on the Power Board. Alternatively, the battery terminals can be soldered on the B+ 
and B- pads, which are located around J1 as per the marked polarity. 

5. Set the Input Power Selection Switch (SW1) on the Power Board to the ‘Battery Input’ position. The Power LED (LED1) 
on the CY4532 EVK turns ON. 

Note: In Rev ** of the CY4532 EVK, the LED1 will blink for a second to indicate that the kit is powered. 

6. Connect a USB Type-C Power Adapter on the USB Type-C port (J10) of the CY4532 Main Board. 

Important Note: The USB Type-C Power Adapter should not be connected to the USB Type-C port (J13) located on the 
CY4532 Power Board. This port (J13) is meant for using the CY4532 EVK Power Board as an external programmer with 
Cypress EZ-PD products that support bootloading using CC lines. See the Common Problems and Troubleshooting 
section for more details. 
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Figure 5-2. Setup for Charging a Battery Attached to CY4532 EVK 

 

7. Verify that LED1 remains green, which indicates that the board is powered. 

Note: While the battery is being charged using the USB Type-C Power Adapter, a USB Type-A device such as a mobile 
phone can be charged by connecting it to the USB Type-A port. 

5.2.2.2 Providing power on USB Type-C and USB Type-A ports 

1. Disconnect the USB Type-C power adapter from the CY4532 EVK Main Board. 

2. Connect a USB Type-C device that needs to be charged to the Type-C port (J10) located on the Main Board. The Power 
LED (LED1) on the CY4532 EVK Power Board remains ON to indicate supply of power on J10. 

Note: In Rev ** of the CY4532 EVK, the LED1 will blink for a second to indicate that the kit is powered. 
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Figure 5-3. Setup for Providing Power on USB Type-C and USB Type-A Ports 

  

Note: 

 Make sure that a charged Lithium-ion battery is connected to the battery terminal (J1) and switch SW1 is at 
‘BATTERY INPUT’ position before connecting the USB Type-C device for charging. If the battery is connected after 
the USB Type-C device is connected, the USB Type-C device can end up charging the Lithium-ion battery. 

 The voltage provided by the CY4532 EVK to the device is determined based on the USB PD contract negotiated 
between the CY4532 EVK and the device. This voltage can be monitored at the VBUS_P test point (TP14) located 
on the Power Board. 

 A USB Type-A device also can be connected to the USB Type-C port (J10) for charging using a USB Type-C to 
Type-A converter. 

3. Connect a USB Type-A device such as a mobile phone on the USB Type-A port to charge it. 

Note: CY4532 supports simultaneous charging through the USB Type-C and USB Type-A ports. The voltage provided 
by the CY4532 EVK to the device connected on the Type-A port can be monitored at the SUPPLY_TYPE_A test point 
(TP12) on the Power Board. 

4. Check the user feedback provided by the device connected to the USB Type-C and/or Type-A interfaces to determine 
the charging status. Disconnect the devices from the CY4532 EVK once charging is completed to the desired level. 

Note: If CY4532 is no longer providing power through the USB Type-C and/or Type-A ports, the Lithium-ion battery 
connected to the EVK may require charging again. Repeat the steps specified in the Charging the Battery Attached to 
CY4532 EVK section to charge the battery. 
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5.2.3   Common Problems and Troubleshooting 

Table 5-4. Common Problems and Troubleshooting for PB Application 

# Issue Possible Cause Possible Solution(s) 

1 USB Type-C or Type-A device 
connected to CY4532 is not 
charging. 

Switch SW1 may not be in the ‘BATTERY 
INPUT’ position. 

CY4532 may not have been loaded with 
‘Power Bank’ firmware. 

Set the Switch SW1 at ‘BATTERY 
INPUT’ position. 

Download ‘Power Bank’ firmware using 
the details provided in  
Chapter 4. Programming the EZ-PD 
CCG3PA Controller. 

2 The Power LED (LED1) does not 
turn ON when SW1 is positioned at 
the ‘BATTERY INPUT’ position after 
connecting the battery. 

The battery may not have adequate charge 
to power the EVK. 

 

 

Charge the battery by connecting a USB 
Type-C Power Adapter on the Type-C 
port (J10) of the CY4532 Main Board. 

 

3 The battery is not charging after 
connecting the USB Type-C Power 
Adapter. 

Jumper settings on the Main Board and 
Power Board may not be set for Power Bank 
application. 

 

The USB Type-C Power Adapter might have 
been connected to the USB Type-C port 
(J13) located on the CY4532 Power Board. 

 

 

The battery type (1-Cell/ 2-Cell) configured 
on the CY4532 EVK hardware and firmware 
may not match with the type of battery (1-
Cell/ 2-Cell) connected to the EVK. 

Ensure that the jumpers on Main Board 
and Power Board are set for Power 
Bank application. 

 

Ensure that the USB Type-C Power 
Adapter is connected to the USB Type-C 
port (J10) located on the CY4532 Main 
Board. 

 

Configure the EVK hardware and 
firmware to match with the type of 
battery used.  

See Appendix B - Configuring CY4532 
EVK for 1-Cell or 2-Cell Li-Ion Battery 
Operation for details. 

4 The device connected to the USB 
Type-A port gets charged 
intermittently. 

The device may implement a proprietary 
charging protocol instead of BC 1.2, QC, 
Apple Charging 2.4A or Samsung AFC 
protocols. 

CY4532 EVK supports charging using 
BC 1.2, QC, Apple Charging 2.4A, and 
Samsung AFC protocols. Make sure that 
the device connected to CY4532 EVK is 
compliant with one of these protocols. 

5 Unable to charge through the USB 
Type-C and USB Type-A ports 
simultaneously.  

The output from the Li-Ion battery connected 
to the EVK may not be adequate to supply 
the required power to the devices connected 
to both the ports. 

Use a battery with a higher output rating. 
CY4532 EVK can support 2-cell 
batteries with rating up to 8.4 V, 5 A. 

6 Charging of the devices connected 
on the Type-C and Type-A ports 
goes through intermittent charging 
cycles before it stabilizes. 

CY4532 EVK supports multiple charging 
protocols (QC, AFC, BC 1.2, Apple Charging 
2.4A). The communication between the EVK 
and the device being charged to align on the 
optimal voltage and current settings can 
happen in steps. 

None 

7 Type device connected to the USB 
Type-C ports does not charge or 
stops charging. 

The CY4532 EVK implements OCP for 
safety reason. This shuts down charging on 
Type-C port if the current exceeds a certain 
limit. By default, this limit is set to 2 A. 

Check if the device connected to the 
USB Type-C port can be configured to 
set the current consumption limit to 2 A. 
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5.3   Using the CY4532 Power Board as a Programmer 

This section explains how to use the CY4532 Power Board as a Programmer for external hardware with a Cypress EZ-PD 
CCGx Product supporting the CC bootloading feature. This feature is implemented using the CCG4 controller located on the 
CY4532 EVK Power Board. 

5.3.1   Boards, Cables, and Accessories Needed 
The following items are needed to use the CY4532 Power Board as a Programmer: 

 Items provided with the kit: 

 CY4532 Power Board 

 12 V 50.4 W DC power adapter 

 Items not provided with the kit: 

 Hardware with Cypress EZ-PD CCGx product supporting CC bootloading feature 

 A USB Type-C Electronically Marked Cable Assembly (EMCA) cable 

 A USB Micro-B Cable 

 PC/Laptop installed with the Cypress EZ-PD Configuration Utility 

Note: The CY4532 kit installer installs the EZ-PD Configuration Utility by default. 

5.3.2   Using the CY4532 Power Board as a Programmer 
1. Remove the power supply connected on the DC Jack (J3) of the CY4532 Power Board. 

2. Detach the CY4532 Main Board pre-mounted on top of the CY4532 Power Board.  

Note:  

 To remove the CY4532 Main Board, it is recommended to hold it around the longer edges of the board and lift it up. 

 No specific jumper setting is required on the CY4532 Power Board to use it as a Programmer. 

3. Connect a USB Type-C EMCA cable between the USB Type-C port (J13) of the CY4532 Power Board and the USB 
Type-C port on the external hardware. 

4. Connect the USB Micro-B cable between the USB Micro-B port (J12) of CY4532 Power Board and a USB Type-A port 
of the PC/laptop. 

Note: For the Rev ** of the CY4532 EVK, use USB Type-A to Mini-B cable. 
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Figure 5-4. Setup for using CY4532 Power Board as Programmer 

 

5. Connect the 12 V DC power adapter provided with the kit to the CY4532 Power Board’s DC Jack (J3). 

6. Set the Switch (SW1) on the Power Board to the ‘DC INPUT’ position.  

7. Invoke the EZ-PD Configuration Utility on the PC/laptop and follow the programming procedure described in the User 
Manual of the utility. You can also click Help > User Manual in the EZ-PD Configuration Utility to access this user manual. 
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A. Terminology 
 

 

Terminology 

This guide assumes that the user of the CY4532 EZ-PD CCG3PA EVK is familiar with the fundamentals of the Type-C 
connectivity and the USB Power Delivery protocol. A brief description of Type-C terms is provided here for reference. 

 Alternate Modes: A feature of a USB Type-C system whereby one or both SuperSpeed lanes may be repurposed for use 
with a different serial protocol, such as a DisplayPort, eSATA, or Thunderbolt. 

 Client: A USB peripheral such as a hub, docking station, or monitor. 

 Configuration channel (CC): A USB Type-C bus wire used to transmit protocol signals. This is a half-duplex 300 kHz 
signal.  

 Consumer: A Type-C port that sinks power from VBUS. 

 DisplayPort: A digital display interface standard developed by the Video Electronics Standards Association. It is used 
primarily to connect a video source to a display such as a computer monitor. 

 Downstream facing port (DFP): A USB Type-C port on a host or a hub to which devices are connected.  

 Dp, Dn: USB Type-C bus wires used to transmit and receive USB 2.0 data. 

 Dual-role port (DRP): A USB Type-C port that can operate as either a DFP or a UFP. 

 Electronically Marked Cable Assembly (EMCA): A USB cable that includes an IC that reports cable characteristics (such 
as current rating) to the Type-C ports.  

GNDRX2pRX2nVBUSDnCC SBU1DpVBUSTX1nTX1pGND

GNDTX2pTX2nVBUSSBU2 VCONNVBUSRX1nRX1pGND

B1B2B3B4B5B8B9B10B11B12

A12A11A10A9A8A7A6A5A4A3A2A1

2.4mm
2.5mm

GNDRX2pRX2nVBUSDn1CC1 SBU1Dp1VBUSTX1nTX1pGND

GNDTX2pTX2nVBUSSBU2 CC2VBUSRX1nRX1pGND

B1B2B3B4B5B8B9B10B11B12

A12A11A10A9A8A7A6A5A4A3A2A1

Dp2Dn2

B6B7

USB3.0 Type-C Plug USB3.0 Type-C Receptacle

 
 Host: A USB Host system such as a PC, notebook, and laptop.  

 Provider: A Type-C port that sources power over VBUS.  

 Sideband use (SBU): A USB Type-C bus wire used for non-USB control signals, such as DisplayPort control signals. 

 Type-C Transceiver: A transmitter/receiver that communicates over the CC. 

 TX1p, TX1n, RX1p, RX1n, TX2p, TX2n, RX2p, and RX2n: USB Type-C bus wires used to transmit and receive 
SuperSpeed USB and PCIe or DisplayPort data. 

 Upstream facing port (UFP): A USB Type-C port on a device or a hub that connects to a host or the DFP of a hub. 

 USB Power Delivery (USB PD, PD): A new USB standard that increases maximum power delivery over USB from 7.5 W 
to 100 W. 

 USB Type-C (Type-C): A new standard with a slimmer USB connector and a reversible cable, capable of sourcing up to 
100 W of power and supporting Alternate Modes. 

 VBUS: A USB Type-C bus wire used for power; initially 5 V, but can be increased up to 20 V on USB PD systems. 

 VCONN: A USB Type-C bus wire used to power the IC in the EMCA. 
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B. Configuring CY4532 EVK for  
1-Cell or 2-Cell Li-Ion Battery Operation 

                                                                                                                               

1-Cell Lithium-ion batteries support an operating voltage range of 2.7 V to 4.2 V while 2-Cell batteries support an operating 
voltage range of 5.4 V to 8.4 V. The CY4532 EVK hardware and firmware are configured, by default, to support 2-Cell battery 
operation. However, the CY4532 EVK can also be configured for 1-Cell battery operation.  

Note: 1-Cell Lithium-ion batteries operate at low voltages and are typically used for low power applications.  

The CY4532 kit operates at much higher efficiency with a 2-Cell Lithium ion battery. The 2-cell battery provides a longer 
duration of charging as compared to a 1-Cell battery. It is highly recommended to use 2-Cell Lithium ion batteries (default 
configuration) with the CY4532 kit. This is a reference for 1-Cell battery: http://www.batteryspace.com/custom-li-ion-18650-
battery-3-6v-2600mah-9-36wh-2a-rate-battery---un38-3-passed.aspx. 

The hardware and firmware configuration settings on the CY4532 kit must be updated for 1-Cell operation, as described in 
the sections Hardware Update for 1-Cell Battery Operation and Firmware Update for 1-Cell Battery Operation. 

B1.1 Hardware Update for 1-Cell Battery Operation 

1. Remove the power supply or the battery connected to the CY4532 EVK. 

2. Detach the CY4532 Main Board from the CY4532 Power Board 

Note: To remove the CY4532 Main Board, it is recommended to hold it around the longer edges of the board and lift it 
up. 

3. De-populate the 0 Ω resistor located at R14 and populate the same at R23. 

Note: In case a new resistor is populated at R23, make sure that it meets the following specifications: 

 0.0 Ω, 0603 Package, 22.4 A Current Rating 

 

 

 

http://www.batteryspace.com/custom-li-ion-18650-battery-3-6v-2600mah-9-36wh-2a-rate-battery---un38-3-passed.aspx
http://www.batteryspace.com/custom-li-ion-18650-battery-3-6v-2600mah-9-36wh-2a-rate-battery---un38-3-passed.aspx
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Figure B-5.  Hardware Configuration for 1-Cell and 2-Cell Battery Operation 

 

 

4. Mount the CY4532 Main Board on the CY4532 Power Board. 

The hardware is now ready for 1-cell battery operation. 

Note: To switch from 1-cell battery configuration to 2-cell battery configuration (factory default state), de-populate the resistor 
from R23 and populate the same at R14. 

B1.2 Firmware Configuration Update for 1-Cell Battery Operation 

Make sure to download the Power Bank application firmware using the procedure described in Chapter 5. Kit Operation before 
updating the firmware configuration for 1-cell battery. 

1. Set the jumpers on the CY4532 Main Board and Power Board as listed in Table B-1: 

Table B-1. CY4532 EVK Jumper Settings for the configuring the battery type 

Board Type Jumper Header Status 

Main Board J2 Short 2 and 3 

J3 

J4 

J6 Short 1 and 2 

 J5 

J7 

Power Board J6  

Open J7 

J9 

2. Power the CY4532 EVK using a 1-Cell battery to the battery terminal (J1). 

3. Connect the USB Type-A to Mini-B cable from the host PC to the J12 connector on the Power Board as shown in 
Figure B-2.  



   Configuring CY4532 EVK for  
1-Cell or 2-Cell Li-Ion Battery Operation 

CY4532 EZ-PD™ CCG3PA Evaluation Kit Guide, Doc. No. 002-18680 Rev. *B 43 

Figure B-2. Set-up for Configuring Firmware Settings for1-Cell on CY4532 EVK 

 

 

4. Launch the EZ-PD Configuration Utility as shown in Figure B-3. The EZ-PD Configuration Utility can be opened from: 
Windows > Start > All Programs > Cypress > EZ-PD Configuration Utility > EZ-PD Configuration Utility. 

Figure B-3. EZ-PD Configuration Utility 

 

5. Select File > Read from Device as shown in Figure B-4. See the EZ-PD Configuration Utility User Manual for more 

details. You can also click Help > User Manual in the EZ-PD Configuration Utility to access this user manual. 

http://www.cypress.com/documentation/software-and-drivers/ez-pd-configuration-utility?source=search&cat=software_tools
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Figure B-4. Invoking Read from Device Menu Item 
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6. Select UFP-AMA from the Read from Device dialog box and click Read as shown in Figure B-5.  

Figure B-5. Reading the Current Firmware Settings 

 
 

7. Select Battery Configuration from the firmware configuration settings and change the value for Battery maximum 

voltage (mV) to match the voltage rating of the 1-Cell battery being used as shown in Figure B-6. The typical voltage 

rating of 1-Cell battery is 4200 mV. 

Figure B-6. Updating Battery Configuration 
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8. The 1-cell operates at a lower efficiency and the application might require limiting a Source PDO Maximum Current  

to 1 A. To change the Source PDO on the Type-C port follow the settings as shown in Figure B-7. 

Figure B-7. Updating Source PDO 

 

Note: Other Source PDOs can be modified similarly as per the requirement of the Sink and Battery capabilities. 

9. Select File > Save As and specify a path to store the updated firmware settings in a .xml file as shown in Figure B-8. 

Figure B-8. Saving Updated Firmware Settings 

 

 

10. Select Tools > Configure Device. Specify the path to the firmware settings file (.xml), select UFP-AMA as the target 

and click Program in the Configure Device dialog box as shown in Figure B-9.  
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Figure B-9. Downloading the Firmware Settings 

 

 

11. Upon successful completion of the firmware settings update process, a window with the message “Flash updated 

successfully” is displayed as shown in Figure B-10. Click OK. 

Figure B-10. Configuration of Firmware Settings Update Process 

 

12. Power off the CY4532 EVK by removing the battery. 

13. Set the jumpers on the CY4532 Main Board and Power Board as listed in Table B-2. 
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Table B-2. CY4532 EVK Jumper Settings for the Power Bank application 

Board Type Jumper Header Status 

Main Board J2 Short pins 2 and 3 

J3 

J4 

J6 Short pins 1 and 2 

J5 Open 

J7 

Power Board J6 Short pins 1 and 2 

J7 

J9 

J14 

 

14. Connect a 1-Cell battery to the EVK and start the usage. 

Note: To switch from 1-cell battery configuration to 2-cell battery configuration (factory default state), repeat steps  
1 to 9 and use configuration settings shown in Figure B-11. Also, use a 2-cell battery to power the EVK instead of 1-cell 
battery. 

Figure B-11. Default 2-Cell Configuration Settings 
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C. Identifying the Application Firmware Type 
 

 

Follow these instructions to identify the application firmware type (PA/PB) loaded on the CY4532 EVK: 

1. Connect the power adapter to the DC Jack (J3) of the CY4532 EVK Power Board. 

2. Set the Input Power Selection Switch (SW1) on the Power Board to the ‘DC input’ position. 

3. Now use a Multi-meter and measure the voltages on the yellow test-points TP11 (CC1 test-point) and TP8 (CC2 test-
point).  

Follow Table C-1 to identify the application firmware type. 

Table C-1. Voltage at CC lines for PA and PB applicaitons 

Conditions Application Firmware Type 

Case 1: Voltage on both TP11 and TP8 ≥ 2.8 V Power Adapter FW (PA) 

Case 2: Voltage on both TP11 and TP8 ≤ 2.0 V Power Bank FW (PB) 

Case 3: None of above Case 1 or Case 2 Reprogram the board with PA or PB firmware 

 

Figure C-1. Setup to Identify the Application Firmware Type 
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D. CY4532 EVK Schematics, BoM, and 
Layout 

 

 

The CY4532 hardware design files are available in <Install Directory>\CY4532 EZ-PD CCG3PA EVK\1.0\Hardware\. 

Note: On the Windows 32-bit platform, the default <Install Directory> is C:\Program Files\Cypress; on the Windows 64-bit 
platform, it is C:\Program Files(x86)\Cypress. 

D1.1 CY4532 EVK Main Board Schematics, BoM, and Layout 

 
CY4532 EVK Main Board Schematics 
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CY4532 EVK Main Board BoM 

# Qty Reference Value Description Manufacturer Mfr Part # 

1 4 
C1, C3, 
C4, C5 

0.1 uF CAP CER 0.1UF 50V X7R 0402 TDK Corporation 
CGA2B3X7R1H104K0
50BB 

2 2 C2, C6 1 uF CAP CER 1UF 35V X5R 0402 
Samsung Electro-Mechanics 
America, Inc. 

CL05A105KL5NRNC 

3 1 C11 4.7 uF CAP CER 4.7UF 50V X7R 1210 
Samsung Electro-Mechanics 
America, Inc. 

CL32B475KBUYNNE 

4 2 C13, C16 2200 pF 
CAP CER 2200PF 2KV 10% X7R 
1808 

Johanson Dielectrics Inc 202R29W222KV4E 

5 2 C17, C20 150 pF 
CAP CER 150PF 50V C0G/NP0 
0402 

Murata Electronics North America 
GRM1555C1H151JA0
1D 

6 1 C18 1.8 nF 
CAP CER 1800PF 50V X7R 
0402 

Murata Electronics North America 
GRM155R71H182KA0
1D 

7 1 C19 22 nF 
CAP CER 0.022UF 50V X7R 
0402 

Murata Electronics North America 
GRM155R71H223KA1
2J 

8 2 C21, C22 390 pF 
CAP CER 390PF 50V C0G/NP0 
0402 

Murata Electronics North America 
GRM1555C1H391JA0
1J 

9 1 D1 
PMEG305
0BEP, 115 

DIODE SCHOTTKY 30V 5A 
SOD128 

Nexperia USA Inc. PMEG3050BEP,115 

10 1 J1 22232051 
CONN HEADER 5POS .100 
VERT TIN 

Molex, LLC 
22232051 
 

11 
 

4 
J2, J3, J4, 
J6 

PRPC003
SAAN-RC 

CONN HEADER .100" SNGL 
STR 3POS 

Sullins Connector Solutions PRPC003SAAN-RC 
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# Qty Reference Value Description Manufacturer Mfr Part # 

12 2 J5, J7 
961102-
6404-AR 

CONN HEADER VERT SGL 
2POS GOLD 

3M 961102-6404-AR 

13 1 J9 
USB 
TYPE A 

CONN RCPT USB R/A TYPE A 
4POS 

Molex, LLC 0676433911 

14 1 J10 
DX07S024
JJ2R1300 

CONN RCPT USB3.1 TYPEC 
SMD R/A 

JAE Electronics DX07S024JJ2R1300 

15 2 J11, J12 

SFH11-
PBPC-
D13-ST-
BK 

CONN HEADR FMALE 26POS 
.1" DL AU 

Sullins Connector Solutions 
SFH11-PBPC-D13-ST-
BK 

16 2 Q1, Q2 
SI7997DP
-T1-GE3 

MOSFET 2P-CH 30V 60A PPAK 
SO-8 

Vishay Siliconix SI7997DP-T1-GE3 

17 2 R1, R8 10K 
RES SMD 10K OHM 1% 1/16W 
0402 

Yageo RC0402FR-0710KL 

18 2 R4, R7 49.9K 
RES SMD 49.9K OHM 1% 1/5W 
0402 

Vishay Dale RCS040249K9FKED 

19 2 R11, R12 100K 
RES SMD 100K OHM 1% 1/16W 
0402 

Yageo RC0402FR-07100KL 

20 1 R16 4.42K 
RES SMD 4.42K OHM 1% 1/10W 
0603 

Yageo RC0603FR-074K42L 

21 1 R19 5.23K 
RES SMD 5.23K OHM 1% 1/10W 
0603 

Yageo RC0603FR-075K23L 

22 1 R20 0E 
RES SMD 0.0 OHM JUMPER 
1W 2512 

Stackpole Electronics Inc. RMCF2512ZT0R00 

23 4 
TP1, TP7, 
TP10, 
TP15 

RED 
TEST POINT PC MINI .040"D 
RED 

Keystone Electronics 5000 

24 4 
TP6, TP8, 
TP11, 
TP18 

YELLOW 
TEST POINT PC MINI .040"D 
YELLOW 

Keystone Electronics 5004 

25 2 
TP16, 
TP17 

BLACK 
TEST POINT PC MINI .040"D 
BLACK 

Keystone Electronics 5001 

26 1 U1 
CYPD317
1-24LQXQ 

USB TYPE-C PORT 
CONTROLLER 

Cypress Semiconductor CYPD3171-24LQXQ 
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CY4532 EVK Main Board Layout 
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D1.2 CY4532 EVK Power Board Schematics, BoM, and Layout 

 
CY4532 EVK Power Board Schematics 
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CY4532 EVK Power Board BoM 

# Qty Reference Value Description Manufacturer Mfr Part # 

1 3 C1, C93, C103 1 uF CAP CER 1UF 50V X7R 
0603 

Taiyo Yuden UMK107AB7105KA-T 

2 14 C2, C3, C20, C26, 
C27, C28, C36, 
C39, C41, C42, 
C57, C73, C89, 
C90 

0.1 uF CAP CER 0.1UF 50V X7R 
0402 

TDK Corporation CGA2B3X7R1H104K050BB 

3 16 C4, C5, C6, C8, 
C9, C10, C13, C14, 
C15, C16, C17, 
C18, C55, C62, 
C71, C78 

22 uF CAP CER 22UF 35V JB 
1206 

TDK Corporation C3216JB1V226M160AC 

4 14 C7, C11, C12, C19, 
C52, C53, C54, 
C60, C61, C68, 
C69, C70, C76, 
C77 

10 uF CAP CER 10UF 50V X5R 
1206 

Murata Electronics 
North America 

GRM31CR61H106MA12L 

5 4 C21, C22, C33, 
C34 

47 pF CAP CER 47PF 50V 
C0G/NP0 0402 

Murata Electronics 
North America 

GRM1555C1H470JA01D 

6 1 C23 0.1 uF CAP CER 0.1UF 50V X7R 
0603 

Kemet C0603C104M5RACTU 

7 1 C25 47 nF CAP CER 0.047UF 25V 
X5R 0402 

TDK Corporation CGA2B2X5R1E473M050BA 
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8 1 C29 22 nF CAP CER 0.022µF 50V 
X5R 0402 

TDK Corporation CGA2B3X5R1H223K050BB 

9 4 C31, C32, C35, 
C37 

0.01 uF CAP CER 10000PF 50V 
X7R 0402 

AVX Corporation 04025C103KAT2A 

10 8 C38, C40, C81, 
C82, C83, C84, 
C85, C86 

1 uF CAP CER 1UF 35V X5R 
0402 

Samsung Electro-
Mechanics 
America, Inc. 

CL05A105KL5NRNC 

11 2 C43, C44 10 uF CAP CER 10UF 25V X5R 
0603 

Murata Electronics 
North America 

GRM188R61E106MA73D 

12 4 C45, C46, C47, 
C49 

22 uF CAP CER 22UF 6.3V X5R 
0603 

Murata Electronics 
North America 

GRM188R60J226MEA0D 

13 3 C50, C88, C91 4.7 uF CAP CER 4.7UF 10V 20% 
X5R 0402 

TDK Corporation C1005X5R1A475M050BC 

14 8 C51, C56, C63, 
C64, C65, C66, 
C67, C79 

0.001 uF CAP CER 1000PF 50V 
X7R 0603 

Murata Electronics 
North America 

GRM188R71H102KA01D 

15 1 C72 4.7 uF CAP CER 4.7UF 50V X7R 
1206 

Samsung Electro-
Mechanics 
America, Inc. 

CL31B475KBHNNNE 

16 1 C80 10 uF CAP CER 10UF 50V X7R 
1210 

Kemet C1210C106K5RACTU 

17 1 C87 22 uF CAP CER 22UF 6.3V X5R 
0805 

Murata Electronics 
North America 

GRM21BR60J226ME39L 

18 1 C94 4.7 uF CAP CER 4.7UF 50V X7R 
1210 

Samsung Electro-
Mechanics 
America, Inc. 

CL32B475KBUYNNE 

19 1 C96 2200 pF CAP CER 2200PF 2KV 
10% X7R 1808 

Johanson 
Dielectrics Inc. 

202R29W222KV4E 

20 1 C99 0.01 uF CAP CER 10000PF 16V 
X7R 0402 

Kemet C0402C103K4RACTU 

21 2 C101, C102 390 pF CAP CER 390PF 50V 5% 
X7R 0603 

Kemet C0603C391J5RACTU 

22 1 D1 SMBJ24A-TR TVS DIODE 24VWM 50VC 
DO214AA 

STMicroelectronics SMBJ24A-TR 

23 3 D2, D3, D9 PMEG3050BE
P,115 

DIODE SCHOTTKY 30V 
5A SOD128 

Nexperia USA Inc PMEG3050BEP,115 

24 4 D4, D5, D6, D8 1N4148W-7-F DIODE GEN PURP 100V 
300MA SOD123 

Diodes 
Incorporated 

1N4148W-7-F 

25 1 D7 PMEG3050BE
P,115 

DIODE SCHOTTKY 30V 
5A SOD128 

NXP 
Semiconductors 

PMEG3050BEP,115 

26 1 D10 SMBJ24CA-
E3/52GICT-ND 

TVS DIODE 24VWM 
38.9VC SMB 

Vishay 
Semiconductor 
Diodes Division 

SMBJ24CA-E3/52 

27 2 ESD1, ESD2 ESD105B102E
LE6327XTMA1 

TVS DIODE 5.5VWM 
14VC TSLP2-20 

Infineon 
Technologies 

ESD105B102ELE6327XTMA1 

28 1 J1 B2B-EH-
A(LF)(SN) 

CONN HEADER EH TOP 
2POS 2.5MM 

JST Sales America 
Inc. 

B2B-EH-A(LF)(SN) 

29 1 J2 OSTTC020162 TERMINAL BLOCK 5MM 
VERT 2POS PCB 

On Shore 
Technology Inc. 

OSTTC020162 

30 1 J3 694108301002 CONN PWR JACK 
2.5X5.5MM SOLDER 

Wurth Electronics 
Inc 

694108301002 

31 2 J4, J14 961102-6404-
AR 

CONN HEADER VERT 
SGL 2POS GOLD 

3M 961102-6404-AR 

32 1 J5 1935161 TERM BLOCK PCB 2POS 
5.0MM GREEN 

Phoenix Contact 1935161 

33 3 J6, J7, J9 PRPC003SAA
N-RC 

CONN HEADER .100 
SNGL STR 3POS 

Sullins Connector 
Solutions 

PRPC003SAAN-RC 

34 2 J10, J11 SBH11-PBPC-
D13-ST-BK 

CONN HEADER 2.54MM 
26POS GOLD 

Sullins Connector 
Solutions 

SBH11-PBPC-D13-ST-BK 

35 1 J12 10103594-
0001LF 

CONN RCPT STD MICRO 
USB TYPE B 

Amphenol FCI 10103594-0001LF 

36 1 J13 DX07S024JJ2
R1300 

USB TYP C TP MNT DL 
RW SMT RECEP 

JAE Electronics DX07S024JJ2R1300 
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37 1 LED1 GREEN LED GREEN CLEAR 0603 
SMD 

Lite-On Inc. LTST-C190GKT 

38 1 L1 6.8 uH FIXED IND 6.8UH 11.5A 
11.5 MOHM 

Bourns Inc. SRP1265A-6R8M 

39 1 L2 3.3 uH FIXED IND 3.3UH 18A 6.8 
MOHM SMD 

Bourns Inc. SRP1265A-3R3M 

40 1 L3 220 Ohm @ 
100 MHz 

FERRITE BEAD 220 OHM 
0603 1LN 

TDK Corporation MPZ1608S221ATA00 

41 1 L4 1 uH 5 A FIXED IND 1UH 5A 27 
MOHM SMD 

Bourns Inc. SRP4020TA-1R0M 

42 5 Q1, Q2, Q3, Q13, 
Q15 

SI2371EDS-T1-
GE3 

MOSFET P-CH 30V 4.8A 
SOT-23 

Vishay Siliconix SI2371EDS-T1-GE3 

43 8 Q4, Q5, Q6, Q7, 
Q8, Q9, Q10, Q11 

SIR426DP-T1-
GE3 

MOSFET N-CH 40V 30A 
PPAK SO-8 

Vishay Siliconix SIR426DP-T1-GE3 

44 3 Q12, Q14, Q16 SI2300DS-T1-
GE3 

MOSFET N-CH 30V 3.6A 
SOT-23 

Vishay Siliconix SI2300DS-T1-GE3 

45 1 Q18 IRLML9303TR
PBF 

MOSFET P-CH 30V 2.3A 
SOT-23-3 

Infineon 
Technologies 

IRLML9303TRPBF 

46 4 R2, R30, R61, 
R100 

49.9K RES SMD 49.9K OHM 1% 
1/16W 0402 

Yageo RC0402FR-0749K9L 

47 1 R3 330E RES SMD 330 OHM 5% 
1/10W 0603 

Yageo RC0603JR-07330RL 

48 2 R4, R29 499K RES SMD 499K OHM 1% 
1/16W 0402 

Yageo RC0402FR-07499KL 

49 19 R5, R6, R7, R9, 
R13, R14, R19, 
R20, R45, R46, 
R47, R54, R55, 
R56, R75, R78, 
R81, R82, R86 

0E RES SMD 0 OHM 
JUMPER 1/10W 0603 

Yageo RC0603JR-070RL 

50 8 R8, R10, R11, R12, 
R31, R32, R33, 
R34 

1K RES SMD 1K OHM 5% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ102X 

51 1 R15 270K RES SMD 270K OHM 1% 
1/16W 0402 

Yageo RC0402FR-07270KL 

52 1 R16 75K RES SMD 75K OHM 1% 
1/16W 0402 

Samsung Electro-
Mechanics 
America, Inc. 

RC1005F753CS 

53 1 R18 4.7K RES SMD 4.7K OHM 5% 
1/16W 0402 

Yageo RC0402JR-074K7L 

54 2 R22, R50 68K RES SMD 68K OHM 5% 
1/16W 0402 

Yageo RC0402JR-0768KL 

55 6 R24, R52, R65, 
R68, R69, R87 

10K RES SMD 10K OHM 1% 
1/16W 0402 

Yageo RC0402FR-0710KL 

56 1 R25 4.99K RES SMD 4.99K OHM 1% 
1/16W 0402 

Stackpole 
Electronics Inc. 

RMCF0402FT4K99 

57 3 R26, R27, R28 2K RES SMD 2K OHM 5% 
1/16W 0402 

Yageo RC0402JR-072KL 

58 2 R35, R39 24K RES SMD 24K OHM 1% 
1/16W 0402 

Yageo RC0402FR-0724KL 

59 1 R36 4.7K RES SMD 4.7K OHM 1% 
1/10W 0603 

Yageo RC0603FR-074K7L 

60 2 R37, R51 36K RES SMD 36K OHM 1% 
1/16W 0402 

Yageo RC0402FR-0736KL 

61 1 R38 18K RES SMD 18K OHM 1% 
1/16W 0402 

Yageo RC0402FR-0718KL 

62 16 R40, R43, R48, 
R66, R67, R89, 
R91, R93, R94, 
R96, R98, R101, 
R103, R104, R108, 
R109 

100K RES SMD 100K OHM 1% 
1/16W 0402 

Yageo RC0402FR-07100KL 
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63 9 R41, R49, R53, 
R59, R62, R63, 
R83, R85, R106 

0E RES SMD 0 OHM 
JUMPER 1/10W 0402 

Vishay Beyschlag MCS04020Z0000ZE000 

64 2 R57, R60 1M RES SMD 1M OHM 1% 
1/16W 0402 

Yageo RC0402FR-071ML 

65 1 R58 110K RES SMD 110K OHM 5% 
1/16W 0402 

Yageo RC0402JR-07110KL 

66 4 R70, R72, R79, 
R80 

10m RES SMD 0.01 OHM 1% 
1W 1206 

Panasonic 
Electronic 
Components 

ERJ-8CWFR010V 

67 4 R73, R74, R76, 
R77 

2R2 RES SMD 2.2 OHM 5% 
1/10W 0603 

Panasonic 
Electronic 
Components 

ERJ-3GEYJ2R2V 

68 1 R84 5m RES SMD 0.005 OHM 1% 
2W 2512 

Stackpole 
Electronics Inc. 

CSNL2512FT5L00 

69 1 R88 200K RES SMD 200K OHM 5% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ204X 

70 1 R92 10E RES SMD 10 OHM 5% 
1/10W 0402 

Panasonic 
Electronic 
Components 

ERJ-2GEJ100X 

71 1 R95 33K RES SMD 33K OHM 1% 
1/10W 0603 

Yageo RC0603FR-0733KL 

72 1 R97 200K RES SMD 200K OHM 5% 
1/10W 0603 

Panasonic 
Electronic 
Components 

ERJ-3GEYJ204V 

73 1 R102 200E RES SMD 200 OHM 5% 
1W 2512 

Stackpole 
Electronics Inc. 

RMCF2512JT200R 

74 1 R105 0.02R,1W RES SMD 0.02 OHM 1% 
1W 1206 

Yageo PE1206FKM470R02Z 

75 1 R107 51K RES SMD 51K OHM 1% 
1/16W 0402 

Yageo RC0402FR-0751KL 

76 1 SW1 SWITCH Slide Switch SPDT 
Through Hole 

E-Switch 500SSP1S1M1QEA 

77 3 TP1, TP2, TP11 BLACK TEST POINT PC 
MINI .040D BLACK 

Keystone 
Electronics 

5001 

78 4 TP3, TP4, TP12, 
TP14 

RED TEST POINT PC 
MINI .040D RED 

Keystone 
Electronics 

5000 

79 1 U1 SC8802QDER SYNCHRONOUS 4-WAY 
BIDIRECTIONAL BUCK-
BOOST CHARGE-
DISCHARGE 
CONTROLLER 

SouthChip SC8802QDER 

80 1 U2 SC8701QDER SYNCHRONOUS 4- PIPE 
BUCK-BOOST 
CONTROLLER 

SouthChip SC8701QDER 

81 1 U3 CYPD4126-
40LQXI 

USB TYPE-C PORT 
CONTROLLER 

Cypress 
Semiconductor 

CYPD4126-40LQXI 

82 1 U4 TPS63060DSC
R 

IC REG BUCK BOOST 
ADJ 2A 10WSON 

Texas Instruments TPS63060DSCR 

83 1 U5 AP2822AKATR
-G1 

IC USB POWER SWITCH 
SOT25 

Diodes 
Incorporated 

AP2822AKATR-G1 

84 1 U6 MIC29152WD-
TR 

IC REG LDO ADJ 1.5A 
TO252-5 

Microchip 
Technology 

MIC29152WD-TR 

85 1 U7 CY7C65211-
24LTXI 

IC USB TO UART BRIDGE 
DUAL 24QFN 

Cypress 
Semiconductor 

CY7C65211-24LTXI 

86 1 U8 USBLC6-2P6 TVS DIODE 5.25VWM 
17VC SOT666 

STMicroelectronics USBLC6-2P6 

87 1 U9 INA199A3DCK
R 

IC OPAMP CURR SENSE 
14KHZ SC70-6 

Texas Instruments INA199A3DCKR 
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